Iconizer Pro 1.4.8 User’s Manual
Written by Narattaphol Charoenphandhu

This software is a shareware of US$ 15.00, see Registration part below.
Your comment and suggestion are welcome.

Introduction

Iconizer Pro is an application developed for generating a set of 32 bit (16
millions, full colors) icons from any pictures. This feature is normally used
for creating a background of CD, folder or other container windows. The
output icons can also be viewed on any Mac OS but Mac OS 8.5 or higher
is required to view 32 bit color.

System Requirements

Computer :

-An Apple Macintosh or Mac OS-compatible computer with fast PowerPC
Processor, and a hard disk with at least 3 MB free space.

-Monitor must be set to Millions of Colors, unless you cannot view 32 bit
icons, including 32 bit icon of Iconizer Pro application (You should see red
yellow, and magenta color in the icon of Iconizer Pro application.).

RAM Requirement :

At least 5 MB free RAM with Virtual Memory on (6 MB free with Virtual
Memory off) for managing picture with as large as 300 icons (640x480
pixel). If the engine cannot run, please increase free memory from the
application’s Get Info window.

Software Requirements :

-System 8.6 or later. (Mac OS 9.0 or later recommended)
-QuickTime 4.0 or later

-Fonts Times New Roman, Charcoal and Geneva

Get Start

1. Prepare you target image from image editing application (Iconizer Pro is
not an image editor). Image width and height should be x times of 32 oth-
erwise Iconizer Pro will add a border to fill the gap (see Border section).
2. Launch Iconizer Pro application.



3. Import picture. You have 5 ways to import a picture, i.e

Select Picture 320 1. Use Select Picture command
Select Destination 3N
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2. Paste picture to preview area

3. Drag picture file or picture clipping to this box
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4. Select destination folder. Destination folder must be a blank folder or
blank volume (including hard disk, RAM disk and disc image). You have
three methods to select destination.

5. If you want to create blank icons (transparent icons, only their name are
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3. Press this icon

2. Drag empty folder to this area




visible) too, enter amount of blank icons in the text field. You can also cre-
ate blank icons on-the-fly by pressing the Watch Icon, select Create Blank
Icon command from Special menu or Option+click on Iconize button.

6. You can clear preview area by pressing the Trash icon or using Edit menu
command. This command also clears "Create Blank Icon" text field.

7. Finally, press Iconize button or use File menu command to make icons.
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Iconizer Pro Extra

1. Show clipboard : Select Edit menu and choose Show Clipboard.

Clear Preview 38D
Paste Picture 38Y

Show Clipboard...

2. About window : Since Iconizer Pro is powered by Naratt Graphics Lib
and Naratt IconService Lib which are parts of Add Items Pro, the About
window shows the informations of Add Items Pro-emulating engine.

‘ About Add Items Pro... |
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3. Navigation Service : Iconizer Pro fully supports Navigation Service 2.0
or higher (Part of Mac OS 9). If you are running Mac OS 8.6, some fea-
tures may not work properly. Window of Navigation Service is showed as
the following.
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[ Show visible items only ¥ Goto:

@ [_New ||| Open ||[ Cancel | [ Choose |
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4. Contextual Menu : Contextual menus will be shown when press Control
button and click mouse cursor on the file’s name displayed in file-dropping
areas (depicted next page). They allow to open item, reveal item in Finder,
get Finder informations and create preview picture for standard Open/Save
dialog or Navigation Service file browser (see details in next topic).

Open Selection

Show Original
Show Finder Info

Create Preview
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Picture Preview Process

Preview process is a useful feature of an old Open/Save dialog as well as a
modern Open/Save dialog or the Navigation Service. You can preview the
pictures by press “Show Preview” button in Open/Save dialog. Normally,
the pictures which can be previewed must have special codes that allow
QuickTime and QuickTime Power Plug to access and display. If the pic-
tures do not have the preview codes, those softwares must have their own
preview methods, which are risk and slower especially when the pictures




are very large, to display preview. Thus, most softwares do not have their
own global preview processes. If you select pictures which contain no pre-
view code, the result box will show the text “No preview available.”. To
solve this problem, you must incorporate the preview codes to the pictures
by using special graphic programs, e.g. PhotoShop, GraphicConverter and
Iconizer Pro 1.3.3 or later.

Result Box
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The method of adding preview codes with Iconizer Pro is very easy.
After you import your target picture into the main window :

1. Press Control key and click on a picture’s name in “Picture File :”
path area to bring up the contextual menu (depicted on next page).

2. Choose menu command “Create Preview”.

Please note that if your picture already have the preview codes, the



menu command “Delete Preview” will appear instead.
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Clean Up Icon Set

Iconizer Pro 1.3.4 or later allows users to clean up or rearrange the icon set
which is accidentally deranged. Normally, clean up method is faster than
creating a new icon set. Please note that the folder that you want to clean
must contain only Iconizer Pro-generated icons. All icons must also have
embedded Iconizer Pro-generated system registry. If your icon set is creat-
ed by the previous version of Iconizer Pro or your icons are “Blank Icons”,
you must add “Clean Codes” by using Clean menu command “Embed
Codes”. During rearrangement, selected folder is not necessary to be set
view to “by icon”. It can be viewed “by list” or “by button” while the
process is running. After switching to view “by icon” (Use Finder’s View




Clean

Show Coded ltems 38U

Embed Codes #E
Remove Codes 2R

Clean Up Icon Set  88Y

menu command), all icons will be automatically rearranged to their defined
position. The arrangement process will commence after you choose “Clean
Up Icon Set”. Users can remove “Clean Codes” from the icon set by using
“Remove Codes”. To show the coded items, choose “Show Coded Items”.

Tip :

- Before adding “Clean Codes” to the icon set, please make sure that your
icon set has been already arranged in its proper position, otherwise the
undesirable registry will be embedded.

- To retain icon position after moving, you should Select All icons before
move them.

For advanced users

you can command Iconizer Pro to rearrange icon set generated by other
iconizing softwares. However, the method is not simply. Before add the
“Clean Codes” to all icons, you must change type and creator of icons to
“rsrc” and “AITP”, respectively. To change type and creator, you may
write your own converter or use some third party softwares which are avail-
able to download at several archives. If you want to write the automatic
converter by yourselves the code is very simple as below :

OSErr ChangeTypeAndCreator (FSSpec *spec)
{
FInfo info; //Structure Flnfo
OSErr err;
err=FSpGetFInfo(spec,&info);
info.fdType='rsrc';
info.fdCreator="AITP";
err=FSpSetFInfo(spec,&info);
return noErr;



Once icons’ type and creator are set correctly, you can rearrange this icon
set in the same manner as you do with Iconizer Pro-generated one. You
must perform this tip with your own risk.

White Icons Management

Iconizer Prol.3.6 or later allows user to manage the icons which display
absolute white color. Why we need this tool? Because white icons have the
same color as the window background, it is worthless to include white icons
in your container windows. You have two ways to manage white icons as
the following

1. Ask Iconizer Pro to select white icons by using Show White Icons com-
mand from Special menu. This allows you to manage them manually.

2. Ask Iconizer Pro to automatically move all white icons to Trash by using
Trash White Icons command from Special menu. You can permanently
delete them by emptying trash or change your mind and restore the icon set
by moving trashed items back to their original folder and using clean up
method to restore their positions as previously described.

Create Blank Icon B

Show White Icons 31
Trash White Icons 38T

Border of Icon Set

To create a proper icon set, image width and height should be x times of 32
otherwise Iconizer Pro will add a border to fill the gap, as previously men-
tioned. Iconizer Pro 1.4.3 or later provides three types of borders:

1. Border Mask : This type is a transparent border, i.e. no extra white area
appears. This option is activated by default. To deactivate this type, dese-
lect Border Mask (Command+K) from Edit menu.

2. White Border Default : This type is an old default white border in



Iconizer Pro 1.4.2 or older. The white border will appear in right and bot-
tom parts of the image. To activate this type, deselect both Border Mask
and Center Image (Command+G) from Edit menu.

3. White Border Center : This is a new white border. The image will be
placed centrally. To activate this type, select Central Image and deselect
Border Mask from Edit menu.

Clear Preview 3D
Paste Picture 3V

+ Border Mask 8K
Center Image 3G

Show Clipboard...

Add Items Pro Service Lib

In 1999, the element of Add Items Pro was created as a Mac OS shared
library which includes a lot of useful features e.g.
-Naratt Graphics Lib : Help to manage QuickDraw Region
-Naratt IconService Lib : Help to get and set icons
-Naratt Navigation Service : Help to manage NS dialog box
-Contextual Menu Extra : Extended SOMCustomMemoryMgr

In the following year, I incorporated Add Items Pro Service Lib 1.0 into my
two softwares, Add Items Pro 1.0 and Navigation Service Preview Maker.
The former, currently version 1.5, is a tool for managing items of the cus-
tomised folders, usually plugin folders, as Extension Manager does. The
latter has an extension and a control panel. Both allow to create, delete,
copy, paste, get pixel info of or edit preview picture for Navigation Service
dialog box. If Navigation Service Preview Maker is installed, the forth but-
ton will appear on the upper right corner of Navigation Service dialog box.
Now, Add Items Pro Service Lib is embedded into Iconizer Pro 1.3 or later.

Registration

Iconizer Pro 1.4.1 or later is a shareware.



Single user license USS$ 15.00

Site license USS$ 45.00
World-wide site license US$ 90.00
Purchase online at http://order.kagi.com/?69A

Please note that

1.Shareware or freeware developers can pay single user license.
2.Commercial users who distribute CDs with Iconizer Pro-generated icons
inside: 1. with acknowledgement to Iconizer Pro in Read Me can pay sin-
gle user license 2. without acknowledgement must pay site license.
3.Commercial users who want to bundle Iconizer Pro with their products,
e.g. CD-R manufacturers, must pay world-wide site license price.

I promise to send a registration key by e-mail within 5 days after your pay-
ment. The Get Info window of each icon generated by unregistered version
will show an “Unregistered” message.

D eV Damo Info haaea0iammF7— E

S

_5hnw:[ General Information % I

Kind: [conizer Pro 1.4.8 document
Size: 3 K ondisk (5,096 bytes)
YWhere: Macintosh HD:

Created: Fri, Jul 27, 2001, 1:06 PM
Modified: Fri, Jul 27, 2001, 1:08 Pr
Yersion: Unregistered : Generated by [conizer Pro 1.4.8

Label:| None El

Comments:

] Locked [] stationery Pad




FAQ

1. Why I obtain some white icons when source image is extremely large?

This is a minor bug which the element of problem may reside in the system
itself. If the picture is, approximately, larger then 900 icons, you may
observe some white icons. These white icons are not corrupted and can be
displayed normally if you “strongly” refresh them, e.g. open their Get Info
windows and check then uncheck “Locked” check box. Indeed, system
will suffer if you open a folder which contains icons greater that 500 icons.

2. Why are my icons not properly arranged?

Check you Finder “View Options” of your destination. It should be set as
depicted above. To access this window, choose View Options command
from View menu of Finder.

O

[

Demo Window Yiew Options

h Derno " ndons
Yiews: Standard

_lcon View Options

lcon Arrangement:

i Mone
) &ilways snap to grid

B8 (7} Keep arranged: | by Mame <)

s &
Q ®

lcon Size:

[ Set to Standard Views ] Uze options from Preferences

| Cancel I




3. Why don't Clean Up, White Icon or iconizing engines work when there
are non-icon files or folders in the destination?

Iconizer Pro normally modifies the properties of destination folder. It also
checks for some particular internal codes of existing files. Therefore, I do
not want Iconizer Pro to touch your files to avoid several kinds of damages

4. Why icon set built by version 1.3.6 or newer have white bars inside the
graphics?

This problem is very rare. It is caused by some third party softwares which
can modify Mac OS routines, e.g. Natural Order 1.4 and Title Free 1.3.2.
You may use version 1.3.5 instead. Anyway, if your output icon set looks
normal on your computer, it will look normal on other computer too.

If you have other problems or questions, please mail to me or see:
http:// www.naratt.com/troubleshooting.html

Distribution

You can freely distribute a complete package of Iconizer Pro if you want
but not with commercial products, e.g. CD-R hardwares (see Registration).

Contact Informations
WebSite :  http://www.naratt.com
WapSite :  http://www.naratt.com/wap.wml

E-mail : Naratt(@naratt.com

You can also access these informations by using “Contact Information”
command from Iconizer Pro’s Apple Menu.

Disclaimer

My effort has been made to test this application to ensure it performs as
expected, therefore I will not be held responsible for any consequential,
incidental, direct or indirect damages through the use of this software.

Version History

Version 1.4.8
- Improve speed of Border Mask-enhanced iconization.



- Border Mask command-induced Error type 3 was fixed.
- Fixed icon misarrangement when the destination is a DiskCopy image.

Version 1.4.6
- Border Mask command now works properly with Center Image.
- Both Border Mask and Center Image are also activated by default.

Version 1.4.5
- Allow to drop a picture from other applications into the preview area.

Version 1.4.4
- Improve speed of transparent border-enhanced iconization.
- Improve method of registration number recognition.

Version 1.4.3

- Add Border Mask command in Edit menu to create transparent border.
- Add Center Image command in Edit menu to place image centrally.

- Fix bug in "Show visible items only" command in Navigation Service.

Version 1.4.2
- Handle error when create blank icon while the value in text field is zero.

Version 1.4.1

- First shareware release.

- Most engines, including iconizing engine, were rewritten.

- Add Items Pro kernel is updated to version 1.5.2, optimized for G4.

- The iconization is speed up by 15 %, especially on G4.

- Allow to press Option+click on Iconize button to create blank icon.

- Update engine of Show White Icons and Trash White Icons command.
- Both commands now works when the folder contains non-icon items.
- Picture File and Destination areas have some cosmetic changes.

- Destination for Create Blank Icon command must be a volume or folder.
- Fixed error when clear preview while iconizing engine is running.

- Fixed message bug when press modifier key with character key.

- Several minor bug fixed.

Version 1.4
- Personal release.



Version 1.3.9

- Improve speed of engines, button appearance and button functions.

- Nav’s control take action only when mouse is released in that control.

- Fix bug that main window fails to update when users move Nav dialog.
- Fix bug when open compressed image with QuickTime 5 installed.

Version 1.3.8

- Improve quality of icon set when the master is a JPEG image.

- Fix memory leak when open a very large TIFF image.

- Fix Type 10 error when try to access protected volumes.

- Fix system freeze when users quit application while engines are running.
- Update contact information on Iconizer Pro’s Apple Menu command.

Version 1.3.7
- Personal release.

Version 1.3.6

- Add Show White Icons command to show icons with white color.

- Add Trash White Icons command to trash icons with white color.

- Add “Contact Information” command in application’s Apple Menu.
- Move all clean up commands to “Clean” menu.

- Improve icon naming methodology to speed up iconization.

- Icons’ name will look shorter when they are selected.

Version 1.3.5

- Markedly improve speed of iconization by 120%.

- Allow to work properly under the classic environment of Mac OS X.
- Still can be downloaded at http://www.naratt.com/IconizerProl.3.5.sit

Version 1.3.4

- Improve image cache method to reduce memory usage.

- Add clean up commands to Special menu.

- Allow to rearrange or clean up icon set when it is accidentally deranged.
- Clean up codes are automatically embedded to all icons.

- Allow to add clean up codes to icon set created by previous version.

- Allow to remove clean up codes from icon set.

- Change short cut key of “Create Blank Icon” command to Cmd+B.

- Fix bugs when create blank icons while the entered number is zero.



Version 1.3.3

- Improve automatic icon arrangement method to accelerate iconization.
- Destination can be resized, opened or closed while engine is running.
- Destination can viewed either by icon or by list while engine is running.
- Add “Create Preview” contextual menu command.

- Allow to create picture preview for standard “Open dialog”.

- Allow to stop iconization by pressing Command+Period (Cmd+.).

- Allow to stop iconization by move working destination to trash.

- Software information window can be accessed from main window.

- Handle error when the destination does not have enough free space.

- Fix major bugs when the selected destination is an empty volume.

Version 1.3.2 :

- Improve speed of preview process.

- Improve speed of iconization.

- Fix minor bugs when using “Clear Preview” command.

- Add supported picture formats to “Select Picture” Navigation Service.
- Add “New Folder” button to “Select Destination” Navigation Service.
- Change some informations in the icon’s Get Info window.

- Support a picture which is as large as 2,000,000 icons.

Version 1.3.1 :
- Improve user interface.
- Fix some minor bugs.

Version 1.3 :

- First public released.

- Add Items Pro core was updated to version 1.5.1 to improve speed.
- Allow to enter the amount of blank icons.

- Allow to build icons from a picture clipping.

Version 1.2 :
- A part of Add Items Pro 1.5.
- Fix major bugs with Navigation Service 2.0.

Version 1.1 :
- A part of Add Items Pro 1.5.
- Add “Zoom In” and “Zoom Out” options.



Version 1.0 :
- A part of Add Items Pro 1.2.
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